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1.1. Video tutorials for Showcontroller

A collection of tutorial videos to Showcontroller can be found here:

https://www.showcontroller.com/video-tutorials

1.2. About Showcontroller

The laser show software "Showcontroller" consists of several tool for creating and playing professional laser
shows.

Multiple years of development, continuous improvements and implementation of new features make this
software a universal tool that enables show designer to implement their ideas and visions.

Like nearly no software product is bug free, Showcontroller doesn't claimt to be either - however, if bugs are
reported they get fixed within short notice to provide the best possible user experience.

The main features of Showcontroller:

- Timeline-based animator "RealTime" to create music synchronous laser shows

- 3D drawing tool "PicEdit"

- Extensive OpenGL preview, alternatively it is also possible to use Realizzer(tm) for visualization. 
 
- Live-Tool "Showcontroller Live"

- Further tools for creating laser frames, e.g. Tracer and SVG Converter

- Import of 3D animations from Blender / Freestyler PlugIn. The software "Blender" if freeware..

It is possible to program 16 separate timeline tracks. These can be mapped to up to 20 hardware output
interfaces (USB or LAN).
Each of these 20 output channels can be perfectly adjusted to the connected laser system (Size, offset,
colors, linearity, etc.).

Thus it is also possible to control 16 separate DMX universes. As an option, the DMX signal of the track can
also be assigned to an Artnet universe. 

Only one program can access the hardware output interfaces at the same time. If PicEdit is opened first,
and then RealTime, RealTime cannot output until PicEdit has been closed or the laser output has been
deactivated.
RealTime opens interface access on click on "Play" and closes it on click on "Stop". After the access to
the interfaces has been closed, other programs or program parts can access them.

1.3. Installation of Showcontroller

For always providing the latest software version, there is no installation CD included ind elivery of the
Showcontroller software package.
The latest installer of the full version can be found on the showcontroller website HERE.

The full version only works with a license dongle connected!

To test the sofwtare, a Demo version of Shocontroller can be downloaded HERE. The Demo version has all

https://www.showcontroller.com/video-tutorials
https://www.showcontroller.com/downloads
https://www.showcontroller.com/downloads
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features of the full version but just does not support output to hardware DACs.

Start the installer after having downloaded the software package. Showcontroller is installed in two steps.
First, Showcontroller is instlled including all tools and corresponding DLLs. The installer suggests a
standard install directory, usually this "C:\Program Files(x86)\Showcontroller"
Second, the folder for saving user data is created. Standard suggested destination for the User data is the
Desktop. The path to this directory is written to the Windows registry by the installer. The showeditor
programs refer to this path.
It is not possible to just move that folder after the installation has been completed. The software
will not work properly.

After the installation has finshed, the most important Shortcuts to the Showcontroller programs can be found
at the desktop. More Showcontroller programs can be accessed through the start menu.

Fix errors during installation

Missing mfc100.dll
If an errors with "missing mfc100.dll" shows up during program start, the "Visual Studio 2010 Runtime"
needs to be installed. This software package of Microsoft contains all missing DLLs:
https://www.microsoft.com/de-de/download/details.aspx?id=555

Error jmlaser.dll
"Error jmlaser.dll" indicates that the computer does not know or cannot handle the signature of the
jmlaser.dll. The DLLs are signed to prevent manipulation. To obtain the correct certificate, it is necessary to
connect the computer to the internet for some minutes to update the security library.

1.4. Supported hardware for Showcontroller

Showcontroller Hardware
The basic version of Showcontroller support the very common Laserworld ShowNet network interface.

Showcontroller PLUS Hardware
Showcontroller PLUS supports a larger number of additional hardware interfaces.

Some examples:
- Laserworld ShowNet
- Easylase LC
- Easylase II
- Netlase LC
- Netlase 3+1 / 5+1
- various others

This covers the complete range of basic USB to high end LAN output interfaces. All Interfaces support DMX
in/out.

Installation of theLaserworld ShowNet interface
The Laserworld ShowNet interface has many features and different operation modes. Detailled installation

https://www.microsoft.com/de-de/download/details.aspx?id=555
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and configuration instructions can be found in the ShowNet interface, which can be downloaded here:  
https://www.showcontroller.com/downloads/shownet_manual.html

Installation of USB hardware interfaces
There are signed drivers available for all supported USB DACs and for all supported Windows versions.

The respective drivers are on the driver CD provided with the interface

The jmlaser drivers for Easylase II / Easylase LC / nano can be found in the default data folder that has
usually been installed to the Desktop, in the subfolder "Drivers". For manual installation (if the auto-detection
has failed) open the device manager and right click on the very device: 

Select "Update Driver". Then:

"Search for driver software on the computer" ->

https://www.showcontroller.com/downloads/shownet_manual.html
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Click on "Search" and navigate to the respective driver folder.
Usually this is "C:\Users\YOUR USERNAME\Desktop\Showcontroller\Drivers\JM Laser Driver 3.6

After the driver installation has finished, the device can be found in the device manager and identifies as
"USB Laser Geräte"

1.5. Bug and error tracking

Like with any software it is possible that problems occur, which are often related to the operating system. In
most cases these issues can easily be resolved locally.

Answers to questions and further help are provided in the support forum on the Showcontroller
Website:
https://www.showcontroller.com/forum

Tutorials and further tips can be found here:
https://www.showcontroller.com/tutorials

A short list of Problems that sometimes occur:

1. "Error loading jmlaser.dll"
This problem can occur during a new installation or if the computer does not have internet access during
installation.
"Error jmlaser.dll" indicates that the computer does not know or cannot handle the signature of the
jmlaser.dll. The DLLs are signed to prevent manipulation. To obtain the correct certificate, it is necessary to
connect the computer to the internet for some minutes to update the security library.
Windows XP operating systems require Service Pack 3 (SP3) to be installed.

https://www.showcontroller.com/forum
https://www.showcontroller.com/tutorials
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2. First Steps with Showcontroller

This is a short introduction to Showocntroller. All features are explained more in detail further down this
manual.

2.1. Testing the output hardware

After having installed the software and the drivers (if necessary) the functionality of the hardware output
devices should be tested.
Depending on the harware, there is either the tool
"ShowNet Admin Tool" (for Laserworld ShowNet interfaces)
or
"Hardwarecheck" (for interfaces of  JM Laser)

Both tools come with the software installation and can be found in the installation folder of Showeditor

ShowNet Admin Tool:

Furtehr details can be found in the Laserworld ShowNet manual.

Hardware Check:
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The left column shows the discovered hardware interfaces. Information on the hardware device (max.
scanspeed, number of color channels etc.) are displayed in the Status area right next to it.
The IP Address of network hardware devices is also displayed there. Use "Set friendly name" to assign a
custom name to the very device. This helps with identifying it easier later on.
A click on one of the test pictures starts the output. Scanspeed, display size, blank shift etc. can be
calibrated. All these settings only apply to the output test and do not affect any other tools or programs.

2.2. White balance

The most important factor for a clean laser show display is a good white balance.

White balancing a laser projector can be perfected up to ca. 90%, as various factors influence on the
accuracy.+

- The type of laser:
  Older DPSS systems, which are sometimes not temperature stabilized, can already change their
behaviour on small temperature changes

- Linearity of the laser:
  Often the driver electronics cannot provide a super linear power and power curve. Exception are very high
quality Diode or OPLS drivers, e.g. of RTI 

- Power ratio:
  Depending on the power levels of each color a more the intensity levels require different balancing.

White balance in the end is a subjective thing and depends on the spectator, especially in terms of "what is
white".

Showcontroller comes with a test picture called JM Colortestpic.pic . 
Open this picture in PicEdit:
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On first sight, the white outter frame is visible. Inside of this outter frame there are severalö color lines. Each
line consists of 32 color steps. It is normal that this test picture can flicker at a scan speed of 25kpps.
The values of each point span from right (0) to left (255) in 8-bit resolution. This means 32 values in the
modulation spectrum 0 - 5V DC at the laser driver.

If everything was perfect, the output would look exactly like the picture above. However, in reality white often
is blueish and the color lines do not reach to the right limiting line.

So first of all it is necessary to adjust the output curves per DAC. Showcontroller creates one settings file
per hardware interface called "interface_name.jmi". This file is overwritten on closing the program. Therefore
it is important to make sure that only PicEdit is opened during making these settings, otherwise they may
not be preserved.

Click on this icon  to switch to the Control Center:
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At least one interface should be shown in the left part of this window, in this case the EasyLase LC. The
adjustments are made in the right part of this window in the tab "Color Settings".
If there are more than one cards recognized, select the very card to be adjusted first with a click on the
device number.

White Balance
Usually laser systems tend to have a surplus on blue. The optical reference for the adjustments as the white
outter frame.
Select the color to be adjusted by clicking on the respective "Gamma" button in the right part of the window
and adjust the maximum color values by moving the max-fader. Assuming that red is the weakest color (as
an example here), it makes sense to first match a clear yellow. To do so, click Gamma B and reduce the
MAX fader to 0. Then select Gamma G and reduce green with the MAX fader until a clean yellow becomes
visible. Then select gamma B again and add as much blue as is required to make the outter frame actually
look white.
The generated color curve can e.g. look like this: 

In this case, blue has been reduced to 55% and green to 80%. 

The projected outter frame now shows in the color subjectively specified as white. The individual color lines,
however, do not reach the right border. This results from the offset not bein set correctly yet. Many lasers
require a minimum power (often referred to as threshold) for being able to start with outputting.
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Setting the Offset

Settings are conducted wrom red to blue. Click on the matching Gamma button and increase the "Min"
Fader. As soon as connection lines become visible, the setting is 0.3V too high. The values are displayed
below the faders.
Increase all Min-values until the color lines reach the right border.
The color curve could look like this now (depending on the drivers):

Red has the smallest offset, green a bit more and blue the most in above shown case .

Adjust color linearity

Minimuma and maximum values have been adjusted, but the color linearity has still to be adjusted
individually. Perfectly adjusted colors should show a homogenous color dimming behavior when the overall
brightness is reduced, which means that the color lines should fade out homogenously on reducing the
master brightness. 
In most cases it is necessary to bend the color curved a bit, so the color curve is steeper at the beginning
and smoothens to the end. The respective color line should show a linear color gradient from 0 - 100%. 
These color curves can be adjuste with using the horizontal faders right of the Gamma buttons. By adjusting
these fader different options are possible - it requires trying the very effect. Potentially the Min values require
minor adjustments after the color linearity has been set properly.

In our example it is likely that the color green will fade out quicker on reducing overall power than the other
colors.
So this requires adjustments in the upper part. The curve could then look like this:
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The green Gamma fader has been slightly set to left. The shape of the color cuve gives an impression of the
actual impact on the output: The current is reduced slower the higher the power.
Again reduce the intensity fader from 100% to 0% intensity and monitor the laser output. Repeat until all
lines fade out as homogenously as possible and so does the white outter frame.
This means: it becomes darker and darker, but without any color deviation - it stays "white".

If the dimmint down to 15% or 20% works out well, the adjustment should be sufficient. It is very difficult to
modulate a high power, e.g.  10W, laser in lower power ranges.

However, the white balancing is extremely important for professional laser output results. With a bit of
experience it is usually done within several minutes. 

2.3. Play back of the first show

After the hardware interfaces have been installed and the basic adjustments have been made, it's time to
play back the first show.

Start the program "RealTime":
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Go to the menu "File" -> "Open Show". The standard file path for shows is the folder that has been created
on the Desktop during installation, subfolder "Shows". A Demo show with free-to-use music is included in
the installation package. Load this show from the "Shows" folder:

The timeline changes it's length and fills with events.

Click the red "Play" button and start the output. To quickly adjust projection size and position to the show

environment, open the Control Center: 

This window shows:
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Above picture shows that the connected EasyLase´LC has been assigned to track 1 in RealTime. On the
right side of this window it is possible to adjust various options in the tabs Size/Offset, Color Settings,
Multicolor-Setup, Colormapping, Safety Zone and Artnet. The settings are automatically saved on closing
the window with a click on "Hide".

2.4. Adjust global settings in Showcontroller

It is important to adapt the global settings to the very laser system. This also includes the scanning
parameters. It is important to understand the internal system with the handling of output optimization..

If RealTime outputs a laser frame it always uses the globally set scanning parameters.
These ones are pre-set:

- Default   applies to 98% of all beam show applications
- Graphics Should be used for graphics shows, settings are faster for smaller
projection angles
- Raster Even faster on small angles, optimized for raster scanning / raster framing.
be careful with this one!

Foirst select the track to be used in the "Edit" area: 

 
It is possible to program up to 16 indivisual tracks in RealTime.

Open the scanning parameters settings with a click on the Icon 
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The title bar of this window shows, that the parameters for scanner [1] are to be edited. In the upper right the
parameter "Default" is selected.
These are the adjustable values:
On the left side the point rate can be set, in this cas 28kpps. In the center column it is possible to adjust
the interpolation distances and the number of additional points to be drawn before or after a point has been
set. These values should be kept as low as possible. It is recommended to can a point line for testing the
effect and adjusting the values. If the points do not show clean and there are small lines to them, the values
are too low and require adjustment. Click on "Save ScanParameter" to save the settings.

If several interfaces are in use, close this dialog and proceed the same way with the next interface.

2.5. Details on Showfiles in Showcontroller

It is important to know some basics of Showcontroller before getting started with creating own shows.

The whole software is about laser frames, which can be created in PicEdit. These can either be used with
the software as single file (*.pic) or as file collection (*.cat). Both formats will later be implemented to the
showfile. Thus it is sufficient to just pass on the showfile and the audiotrack when sharing the show later.

Advantage of single PICs:
- very easy to sort, can be quickly implemented to the show via the PicBrowser
- show file does not get too big, as only the frames in use become implemented.

Advantage of CATs
- all own frames are in one file, which can quickly and easily be transferred.
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There are two different internal color formats for laser frames. The old system bases on a color buffer that
contains index numbers 0-64 which are each assigned to output colors in the color buffer. This method was
used in gas laser days. Color buffers matching the own system were created, so the show looked the same
on all systems.
A color buffer entry controls up to 6 color channels.

Nowadays RGB frames are the common method for controling colors. The color values are saved as RGB
value. 

The color system to be used can be specified per show with a checkbox in the trickfilm event, which is the
basic event for laser frames on the timeline.

A screenshot of the trickfilm event edit dialog:

A CAT file is used in this example. Start and End picture are  displayed underneath the preview pictures. on
the right side it is possible to specify the output parameters to be used:



User Manual to Showcontroller Laser Show and Multimedia Software

18 / 124

World: Specifies at which size and position the frame is displayed.

Colorbuffer: Specifies the color buffer to be used. Thios is only available if the "RGB" checkbox
is inactive, in this case the RGB colors of the frame would be ignored. 

Rotation Order: Specifies the rotation order in which rotations are calculated

ScanParameter: Specifies the scan parameter to be used for the output (Scan speed, interpolation
values, point repetitions)

It is possible to specify and use up to 32 different worlds, color buffer and scanning parameters per show.
Thus graphics and beam show parts within one show can be displayed with different settings.

All values specified here for display size and colors are finally processed versus the control center values as
final instance.

2.6. Frame transfer in Showcontroller

There are several ways of implemention Frames from PicEdit to RealTime.

Option 1: CAT file
The most extensive is the CAT file, a collection of frames.

Click on the CAT symbol in PicEdit  and the CAT file dialog opens:

Select a free space, e.g. 10, and move the drawn frame to the CAT file by clicking on "Editor->Animator".
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This file can then be saved, and also re-opened and extended later. Click on the same icon  in RealTime
to use the CAT file there. A window opens that allows for opening the cat file with a click on the red button.
The content becomes visible in the preview an the frames can be selected in a trickfilm:

Thus all Pics are collected in one file, but this file can become rather large by time, which is a disadvantage
as usually not all frames from the cat are used in one show. 

Option 2: PicBrowser
The PicBrowser, described more in detail in 7.5. PicBrowser
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Option 3: TempBuffer
This method is preferred by many users: The frames are shared between the program components via the
temporary buffer (TempBuffer). Start PicEdit, draw a yellow circle and click on the icon "Send Pic to Temp"
in the Toolbar.

 

The picture is then saved to the temporary buffer. Switch to RealTime, right click at a free position and
select "Add from Temp" in the showing menu. A trickfilm is created that contains the yellow circle.

Option 4: TempBuffer via empty Trickfilm
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This option also bases in the temporary buffer, but instead of directly creating a trickfiln, an empty trickfilm
is placed in the timeline first. This is opened with a double click. The CAT is empty except for a CAT file has
been loaded previously. 
Select a free space in the CAT window, e.g. 20, and click on the red icon "Get from Temp":

The temporary Pic has then been inserted to the trickfilm on position 20 instead of the picture buffer. It is
possible to exchange frames between PicEdit and RealTime with the features "Get Pic from Temp" and
"Send Pic to Temp".
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3. Showcontroller RealTime

"RealTime" is the main program part of Showcontroller. It is used for creating timeline-based laser shows by
placing laser frames, created in PicEdit, on the timeline and adding effects to them. 
A very realistic OpenGL Preview allows for show programming without laser output.

The following chapters give an overview on how RealTime works and describe many of its features. As the
software is developed further, some features may not be included in the manual yet and will follow in a future
version of this Documentation.

3.1. RealTime interface

The RealTime interface has a clean structure.
The main menu can be found at the top. It gives access to options for file handling, modifications, settings,
etc.

The Toolbar makes features quickly available by mouse click:

The Values E1-E16 (Edit Scanner, the scanner that is active for programming) and O1-O16 (Overlay
Scanner, the scanner that is shown as overlay to ease the process of syncing tracks) specify the active Edit
and Overlay scanner.

The Viewbar is on the left side:
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The first two icons toggle between TimeLine and internal Editor (simplified). The internal Editor
allows for live modifying laser frames during output.

SFX opens a dialog window for implementing preset animations to the timeline

The next icon opens the OpenGL preview.
The Realizzer icon starts data transfer to the optionally available Realizzer App for advanced
Laser & DMX preview ina 3D environment (only available with Showeditor PLUS) 

Die last two Icons enable or disable the laser output

The icons further down specify if the laser output in the preview window shall be a Beam show  or a

Graphics show  .

The PlayBar can be found at the bottom::

These are the basic play back features:
Play "red" plays the complete show from start till end.
Play "black" only plays the part of the show that has been specified with start and end marker.
The other icons are self explaining.

Playback part:

These buttons can be used to set a start and endmarker for the playback of the show. The lasr icon sets the
start marker at the beginning and the end marker at the end of the show.

Marker:

It can be helpful to use markers with certain events when programming. The first icon sets a marker to the
timeline, the second icon deletes all markers. The third icon deletes the marker next to the actual cursor
position.
During playback it is possible to set markers by pressing the space bar.

Zoom:

Use these icons to zoom the view in and out. It's also possible to use the mouse wheel for zooming.

3.2. OpenGL preview in Showcontroller

The OpenGL preview is not only helpful for programming, but is also the basis for video export of the show.
Video exports can be used to provide the client a preview of the show.
The position of the lasers in the preview are saved to the show file. It can be specified in the global settings
whether these show file or the local settings shall be used.

On startup, the preview window looks empty. The title bar shows the timeline position of the timecode and
the remaining playback time.
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Place a laser frame on the timeline  (fastest option is right mouseclick  -> "Add from PicBrowser"):
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The window can of course be scaled to any size and can also be placed on a second screen. Above picture
shows one laser in the center. All 16 possible lasers can be individually placed in the preview window. Richt
click on a projector and drag to move it.
This example shows three laser system placed next to each other:
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The preview icons in the Toolbar specify which lasers shall be displayed nas beam show preview  and

/ or graphics show preview .

The laserframe is still only output to projector 1. Switch to the Control Center. 
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The tracks of the timeline can be assigned to individual output hardware here. In this example there is no
hardware connected. It is possible to assign tracks to hardware interfaces by selecting the respective track
number for the very hardware.
As an example, track number 1 is routet to three different hardware interfaces:

Close the dialog window with click on "hide" to return to the timeline. The preview now shows the frame, that
is on Track "E1" on the timeline, on all three projectors. Potentially set X/Y axis inversions are respected in
the preview too.
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There are further features in the preview window:
- Right click with pressed CTRL key and drag to rotate the projector
- Select a projector and use the scroll wheel to move it on the Z-axis

Different options to reset the preview layout are available in the menu. 

The menu "EditOpenGL" allows for setting different display options like laser intensity, line thickness, etc.
separately for beam and graphics. The settings are applied on saving.
The "Default.ogl" is automatically loaded on startup.

Another example: This is a two scanner show. In this case both satellite projectors have been inverted on
the X-axis to create a symmetrical output:

3.3. Working with the timeline in RealTime

This chapter explains the main features for working on the timeline and with events.

The timeline only spans 10 seconds on startup. On loading a music file (as basis for the show creation)

through the audio settings , the duration of the timeline automatically adapts to the length of that music
file.
It is also possible to manually adjust the show length in the audio settings.

The Event Dialog
Double click an empty space on the timeline to add a timeline event. The event dialog opens:
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The event dialog provides many options, but is structured:
Top-left are the frame events that are used to create content events like laserframes, lissajous, raster, hot
beams or running text. Right next are the effects to control external hardware via DMX or TTL. Below that
video events (in development, only available in Showeditor PLUS).
Various color effects are available in the middle column. The right columns hold rotation, size and movement
effects.

A click on e.g. Trickfilm adds this event to the timeline:

Move the mouse over the event in the timeline and the mouse cursor changes. Click and drag allows to
move or stretch the event. 

Left click selects the event (color changes). A selected event can be copied, pasted, deleted, etc.. Another
left click on another event or to an empty area unselects all events. 

Several events can be selected with left clicking on pressed SHIFT key.
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Another option to select multiple events is dragging a selection frame. Press and hold SHIFT or CTRL and
drag a frame over the events to be selected.
When using SHIFT: the already selected element stays selected.
When using CTRL: the previeously selected events become unselected and only the events within the
dragged frame become selected.

Copy and Paste can be applied like in most programs with using CTRL-C for copy and CTRL-V for paste
(CTRL-X for cut). 
For copy actions: The mouse cursor specifies the track and position. The timeline cursor should be before
the first event and the mouse cursor in the same track as the first event. This a time-track-offset of 0/0 is
created.
For paste actions: The last mouse click sets the timeline cursor position which sets the start time for the
paste action. Objects are pasted to the track the mouse is pointing to.

3.4. The trickfilm-event

The Trickfilm event is the base for all frames. It already contains some features for animations in the event
options.

There are two options to create a trickfilm event:

1. Double click to the Timeline, and the effect dialog opens. The first option in the upper left corner is the
Trickfilm event. Click to insert. The newly created Trickfilm event is empty per default. 
  

    

2. The PicBrowser. Further explained in 7.4. "Special Features" ->  "PicBrowser"
    The PicBrowser creates a Trickfilm event that already contains a laser frame that has previously been
created and saved to the subfolder "PIC". 

Starting with Option 1, there is an empty Trickfilm event in the timeline. Open it with a double click:
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The first tab already shows multiple parameters 

First: Which frame is to be displayed?
There are two options. If the show has a CAT file included (frame catalog), the frames of this catalog are
displayed in the areas BeginPicture and EndPicture. If a different frame is selected for BeginFrame and
EndFrame, the Frames and the ones between them are played one after the other over time. If the same
Frame is selected for both, the frame remains the same.
A click on "Select Pic" opens a larger window for easier frame selection.

Options to the right:
- "Repeat Animation". The animation can be repeated if Start- and End-Index are different 

- "Show on Surface". Specifies the layer in which the frame shall be placed. If one trickfilm event overlays
another one, it can blank out the one on a lower layer. 

- "World" specifies which output zone shall be selected for that very frame, according to the World Settings

- "Colorbuffer" specifies the color table to be used. This only applies, if a color table different to the RGB
standard shall be used. 
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- "Rotation Order" specifies the calculation order for rotation effects. 

- "Scan Parameter" specifies the scan speed this frame shall be played back with. It is possible to specify
up to 32 scanning parameters in one show. 

Enable / Disable Flags:
- "Soft Blank" smoothly fades frames in/out.

- "Soft Color" creates smooth color transitions

- "Depth Cue". Points that are further to the back are displayed darker to create a more realistic depth
effect. Only available for 3D frames. 

- "RGB". To use RGB color instead of Color palettes. This is standard nowadays.

- "Z Clipping". Frames can be "cut off" at a certain depth level. Only available for 3D frames.

- "Optimize" toggles the automatic corner optimization. Default is "on"

There are more tabs available in this event dialog to make adjustments to the trickfilm event:

- "Scan Limit" is a write in/out effect, further explanation at  3.5.5."Effects" -> "Scanlimit"

- "Camera Path" Creates a "3D flight" through a frameset. Necessary for this is a 3D frame and a frame
with a line through the 3D room that specifies the "flight path". 

- "Animator". Collection of several effect. Thus animations can already be applied to the frame in the
Trickfilm event itself. The timeline looks cleaner with that, but the effects are not visible at first sight.

- "Sparkle" creates bright, flashing points in the frame. It is required to select a temporary frame to save the
modified original frame to.

- "Script". A small timeline within the Trickfilm event, similar to a loop event.

- "Morphing". Detailed explanation in 3.5.8. "Effects" -> "Morphing"

- "Picture". Framebuffer as alternative to frames from the CAT-file. Important: If there is a frame specified
here it has priority over frames from the CAT file. 

- "Animation". For loading an animation. Animations consists of several single frames, basically a small
CAT file. These animations can e.g. be created with the SVG converter. Base file could be a 3D animation in
Blender (see 7.6. 3D animation from Blender) 

3.5. Effects in RealTime

Explanation of effects, corresponding settings and functions.

3.5.1. Add effects

Effects in the timeline are always placed below the frame track it shall be applied to (usually this is a
Trickfilm event). This applies to all effect events.

Double click at an empty position in the timeline opens the Event dialog. Like a Trickfilm event it is also
possible to add an Effect event that way. 
Trickfilm events as well as Effect events can easily be moved by drag&drop and altered in duration - even
during live output (in real time).
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It makes sense to place a start and end marker during programming, as the playback timeframe thus is
limited to the relevant part of the timeline. By using the black "Play" button only this show part is played
back (it can also be set to loop).

Markers can be set with the F2 and F3 keys or click on the icons   that sets the marker at the
active cursor position.

An efefct only applies to the next Trickfilm higher up in the timeline tracks. If several Trickfilm events are
applied for the same timespan in the timeline on different timeline tracks, an effect can also be applied to all
of them at the same time. Richt click on the effect and select "Edit Properties of this Event":

"Influence Track Number" specifies which tracks shall be affected by the effect. "Assign all" marks all
tracks. The feature "Part" will be explained further down this manual.

3.5.2. The Animator

The Animator is not an effect, but a configuration option that applies to many effects.
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The "Intensity Effect" is used as example here. ENarly endless different effects can be created with the
Animator, so its recommended to try out the different features, also in combination with other effect events.

It is important to understand the general principle of how the Animator works to be able to transfer this to
other Effect events.

First create a red circle as Trickfilm event on the timeline and the Intensity effect event is placed one track
below.
Both have a duration of approximately 5 seconds.

Open the Intensity Effect with double click. start value is "0" and end value is "1". 
The graph shows a straight line decending from start value "0" to end value "1".

Close the window and move the cursor. The result is that the frame increases brightness from 0% to 100%
over the duration of the frame.

Open the window again and set "Discrete Steps" to 5:
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Close the window and move the cursor. The brighness follows the "stairs" in 5 steps.  

Re-open the effect and set "Repeats" to 2. The course of the effect is repeated:

To push this example further, set Discrete Steps back to 0, Repeats remains on 2. Change the "Type of
Animation" to "Sine-Waveform".
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The created effect fades the frame two times. The animator graph however shows, that the effect starts at
0.5. But the start value is supposed to be 0. This cann be corrected with "Phase".

Another possibility: Creating a strobe effect
Specify the desired length of the effect, press play and count the beat. Open the effect, set phase to 0, set
"Type of Animation" to "Square Waveform".
Repeats set to e.g. 8 (depending on beats count)
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The course of the effect is also graphically shown in the timeline, in this case it shows the display switching
off/on 8 times

By changing the Phase it is possible to let the effect start with on instead of off

The frame is changed to a vertical line now to explain potential begin and end values further. The Effect event
is changes to "Rotate Z".

"Rotate Effect" ist set to start value 0 and end value 1. as a result the line rotates by 360° around the Z-axis.

Set the start value to -0.25 and the end value to +0.25. The frame rotates from -90° to +90°.
As explanation: Value 0 equals 0%, 1 equals 100%.
In case of a rotation (360°) 0.5 would be half of 1, which equals 180°. 0.25 is a quarter thus 90°.

A pendulum is created in the next step. We need a line with start point right in the center and the ending
further below.
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Start value of the rotation is -0.05 and end value is +0.05
Type of Animation is "Sine Waveform" and "Repeat" is set to 4.

Close the window and drag the cursor. The line smoothly swings from the start to the end value and back.
Overall 4 times.

Annotations to "Type of Animation": This value is the last parameter berfore the effect is calculated. The
result is the corresponding curve form or another source. It can also be an external source.

Open the dialog again, start value 0, end value 1, Repeat to 1, "Type of Animation" to "Expression". Select
"MouseX" in the field below. Close the window, press "Play" on the timeline to have the Effect run infinitely
(Start + stop marker, black Play button).

The end value now depends on the mouse position (move left and right) and specifies values between 0 and
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1. There are only rare cases where it makes sense to use the mouse for such an effect. However, also
values like dmx(1) are possible to use the value of an external DMX controller as control variable. midi(1)
would then listen to a MIDI source.

A closer look at the Exponential Function: Base for this is a square and a Rotate-Z event.
Type of animation is "Exponential", start value is 0, end value is 1:

The frame rotates one time, like normal Now adjust the "Exponent" values. Reducing the value <1, the curve
gets bent downwards, if the value is set >1, the bend directs upwards:

The frame rotates faster at the beginning and decreases speed to the end of the animation in this example.

3.5.3. The Curve window

The Curve window is, like the Animator, another option to animate Effect events.
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Examples for this are some of the effects from the Effects Window (double click to the timeline -> Effects
Window -> More, e.g. CurveMove, CurveRotate, etc.) and also the begin / endcurve for the scan limit.

This curve describes the course of the Effect over time based on a start and end value, like in the Animator.
The line in the window corresponds to these values. Minimum number of points is two though.

Where this curve is modified with functions like Sine, Cosine, Rectangle or external sources like DMX or
MIDI in the Animator, it is possible to self draw this curve in the Curve Window.

This is an example from the Scanlimit Feature:

Startede with value "0"to the left, ending with value "1" to the right.

Use this tool  to move the points, e.g. move the right point slightly up with pressed left mouse button:
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It is also possible to add points. Click on the "Add" tool  and place the additional points at the desired
position. Points automatically snap to the grid The grid size can be adjusted at "XY Grid".

Move the points to their positions afterwards, if necessary.
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Above example would result in a significant change of the Effect in the first part and would only change
slightly for the rest of the timeframe.

Custom created curves can be saved for later use at "File" -> "Save".

3.5.4. RGB effect

The RGB Effect is one of the most powerful tools in Showcontroller. Therefore the configuration is a bit more
demanding. All Effects usually work based on the single points of a frame. A square in standard drawing
only consists of 5 points and effects usually apply between those 5 points. The RGB Effect interpolates the
target frame by itself, so the results are much smoother.

What does the RGb Effect do?
It is possible to put custom functions to the RGB color channels to (re)color a frame. 

Put a square to the timeline and add the RGB Effect.
Open the effects dialog with a double click. Three identical adjustment groups show for the color channels
red, green and blue.
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Change the settings:
Deactivate the checkbox "Active" for green and blue. In this example only red is considered.
Set red Frequency begin/end to 1, Phase to 0/0, Amplitude to 1/1 and Offset to 0/0.
Set color "Depends on" to "Point number" and "Color from" to "Linear".
The result is a static gradient of brightness 0 - 100%.

First change the value for "Frequency" to start value 4 and end value 4.
Result:
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There are 4 color gradients now. But the frame is still static, as none of the values of the effect changes over
time - start and end values are static.
Therefore change "Frequency" to start value 1 and end value to 8: 

The efefct becomes rather dynamic now: The number of color gradients changes from 1 to 8 over time.
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With the Offste it is possible to move the starting point. Set "Frequency begin and end to 4, Phase begin to
0 and end to 1

The 4 times color gradient rotates through the frame, as the phasing of the effect wanders through the whole
frame over time.

The Parameter "Amplitude" just controls the level. Try different values here.
Offset ist just a fixed value that adds to the "Amplitude".

Next step: "Color depends on"
Leave the default settings and change "Color depends on" to "X-Coordinate", which means that the effect is
no longer depending on the point number but on the point distance on the X-axis. As a result the effect does
not move following the order of the points but in the horizontal axis.
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change to "Y-Coordinate" end the effect moves along the vertical axis:

"Z-Coordinate" would only make changes to the depth of a frame (would only make sense with 3D frames).

"Point Distance" calculates the multiplier of the ditances of the points to each other. 



User Manual to Showcontroller Laser Show and Multimedia Software

47 / 124

The last fiel "Color From" is set to "linear" as standard.
Set frequency to start2 and end 2 to see the effect better. Phase stays at 0/1, Amplitude at 1/1 and Offset
at 0/0. "Depends on" back to "point number".
Two color gradients with brightness from 0 - 100% appear. Then the brightness flips back to its inital value.

Change "Depends on" to "Sine"
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The gradient now follows a sine. It smoothly fades in and out. Different values for Frequency and Phase lead
to other results. It's recommended to try out different settings.

This example only focused on the red color channel. With using more different color channes, the
application of the effects become more complex, but it is possible to create beautiful color effects. 

3.5.5. Scanlimit

The effect "Scanlimit" is integrated to the Trickfilm event.Frame source can be a picture (tab "Picture", is
used if a picture from the PicBrowser us used) or a picture from the CAT file.

This effect works point based. It does not look that nice on a square with only 5 points, if the points haven't
been interpolated first. A nice example picture is a circle, there is one available in the PicBrowser.
With right click on the timeline "Add from PicBrowser" and select the red circle in the dialog. stretch the
Event to a duration of approx. 5 seconds.

Open the Trickfilm via double click and open the tab "ScanLimit". Select a temporary frame here first, it is
required to temporarily save the calculated results.
There is no calculation if this temporary frame is set to "0"  , so select a free space, e.g. 5:
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Underneath are the buttons "Begin curva" and "End curve". This adjusts the course of the effect over time.
Click on "Begin curve"
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The horizontal axis shows the time, the vertical axis represents the effect value. The curve has 2 values as
standard, begin and end time.
There are buttons in the top left to add points (+), to move them one one level, to erase them (-) and to move
single points. Select the last tool and move the point down right to up right. The start value would be "0" for
the whole course of the timeframe.
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Confirm with "OK". The window closes. Click the button "End curve":
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Here the default transition is 0 - 1. 
This is what happens: Beginning from left the frame is drawn from point 0 to point 0 and the drawing ends to
the right. Then it draws from point 0 to point 1. The value 0 corresponds with 0%, the value 1 with 100%.

Close the window and move the cursor: The frame is drawn over time from 0 to complete. At the middle
position of the timeframe, half of the circle is visible.
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Back to the "End curve" window. Move the start value from 0 to 1 and the end value from 1 to 0.
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Close the window and move the cursor. The Effect has been inverted: At first, the frame is fully visible, but
then disappears (un-drawn).

Back to the "End curve" window to modify the curve. use the "+" tool in the top left and add a point to the
curve area. Use the "move" tool to move the points to the desired position, as shown below:
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The "Begin curve" is still start 0 and end 0
The End curve starts at 0, in the middle of the timeframe it is at ca. 80% and falls back to 0. The frame is
nearly fully drawn at the middle of the timeframe and "un-drawn" to the end.

3.5.6. HSV effect

It is possible to modifa a frame by using a combination of the effects Hue, Saturation and Lightness (HSV)

To explain the relation between H-S-V: 
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The parameter "Hue" describes the Color in angles from 0 - 360°, "Saturation" the saturation increasung to
the center direction white. "Lightness" describes how bright the color should be displayed, from black to
highest brightness.

The color of a frame is processed from the RGB color model to HSV during effects processing. After the
values have been adjusted on the HSV level, they get processed back to RGB.

It does not make sense to use a white frame with the HSV effect, as all values would be at 100%.
A red circle is used in this example, and a Hue effect event is added to the timeline to change the color
angle. Open the effect with a double click and enter start value 0 and end value 1. The result is a gradient
over time of the full color spectrum. If the fader is placed in the middle of the course of the timeframe, the
effects value would be 0.5 which corresponds to 180°. Thus the frame is cyan.
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Set both start and end values of the Hue effect to 1 - this corresponds to a shade of red. Add the Saturation
effect. This results in a color change of the initial color to white.

Start value of Saturation to 1 (outter border of above graphics), end value to 0 (center of the circle). The circle
recolors over time from its initial Hue color to white. It is possible to adjust begin and end values and many
other aspects (Steps, repeats, etc.), as the course of the effects relies on a regular Animator funcion

Add the Lightness (Val) effect. It is similar to "Intensity" - the HSV graphics shows what happens: The
brightness changes from top (1, bright) to bottom (0, off)

3.5.7. Prism effect

The prism effect is similar to the one known from conventional moving lights or scanners: It multiplies a
projection x-times.

In order to actually have the projection fit the projection are it is necessary to chose a frame that is not too
big in dimensions. In this example a small yellow square is used. It has been added from the PicBrowser.

Place the Prism effect event below:
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Open the effect dialig with double click:

Open the animator dialog with a click on Animator. It refers to the radius. Begin value is 0.3, end value the
same. Prism count set to 3. Click OK and move the cursor:

The source frame is then arranged 3 times on a circle around the center.

Open the effect again with double click and click "Auto Rotation".
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The frames now are rotated in a way that the match the circle (all facing to the center).

Open the effect again, change to the Animator. Start value to -0.4, end value to +0.4, type of animation "Sine
Waveform"
Close the window and move the cursor on the timeline. The radius the frames are arranged to changes over
time. The Prism effect can of course also be combined with further effect events, e.g. rotations, color effects,
etc.

Change the frame to a small spline like shown below: 
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Set Radius begin and end to 0, Auto rotation to on, Prism count to 5:

Many features can be discovered by trying out different options and settings. E.g. try to add a scan limit and
an RGB effect.

3.5.8. Morphing
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The Morphing dialog can be found in the Trickfilm. Source for the morphing effect are 2 or more frames from
a CAT file.
Instead of a direct switching between these picture, the morph effect creates a smooth transition from one
frame to the other.

It is necessary to mind some important aspects when creating a morphing. 
How does the morph effect actually work? 
In the beginning there is a point that is included in the start and in the end frame (e.g. point number 1). The
Trickfilm calculates the points in between these two point positions over time and adds additional frames to
the animation. The correlation of the points to each other base on their number in the figure. 
If the number of points in the start and in the end frame, additional points are added automatically to make
the morphing possible. It makes sense that start and end point are not too far away from each other to avoid
strange morphing behavior.
In a square the first point is in the top left corner, in a circle it is at 3 o'clock position.On morphing from
square to circle this first point makes his way to the corresponding point in the circle (at 3 o'clock position).
The whole frame becomes flipped.
If the circle is created in a way that the point number 1 is at 11 o'clock position, the first points of both
frames would be much closer together and the effect would apply better.

This is a step by step example of a frame morph:

Start PicEdit and RealTime parallely. Draw a red square in PicEdit and copy it to the temporary buffer with a
click on the arrow pointing right ("Send to Temp").

Create a Trickfilm in RealTime, stretch it to about 5 seconds duration and double click. Search a free space
in the CAT window and insert the suqare with "Get from Temp" (click on arrow to the left):

Back to the PicEdit, draw a green circle. Mind the position of the starting point (see above), it should be at
around 11 o'clock: Usually it is at the 3 o'clock position. press "A" to mark all points. Select the rotate tool 

 . To rotate the circle, click exactly in the center of the circle and keep the mouse button presses. The
first click specifies the swivel. Move the mouse (with still pressed mouse button) and move it until it is at the
correct position.
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As it may be difficult to identify point number 1, open the Active Point Dialog with a click on  . This
allows for stepping through each point of a figure. The active point gets selected. 

Proceed the same way as described above to get the frame to RealTime. Place the Circle in the position
next to the square, here the square is in 10, the circle in 11:

Important: Select in the upper part "Begin Picture" number 10 and for "End Picture" use 11.
Switch to the Tab "Morph":

Not much to do here though. Select a free position in the CAT file where the software can temporary buffer
the calculation. In this example it's 12. As long as this frame's value is 0, no morphing happens to it.
If the morph effect shall span more than 2 frames, also activate "enable AutoAnimation". This morphs
through all pictures between the start and end framnem, meaning 1 to 2, 2 to3, 3 to 4 etc. - otherwise the
morphing only happens between the start and the end frame.
The morph transition is linear. as an alternative it is possible to adjust the curve with a click on "Curve".

Close the dialog and click the black Play button (or use the manual preview):

Start:
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At 50% of the time

At 75% of the time
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at 90% / 4.9 of 5 seconds ...

... is the morph animation nearly ready. If this should happen earlier or the circle should stay for longer, it
can be adjusted in the Curve settings in the Morph window.
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It's clearly visible that the standard morph curve is linear. The curve Window is explained more in detail in
3.5.3.

Add another point and move it as shown below:
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Now the end value is already reached at 70% of the timeframe. The blue line reaches until the right border,
just very low and straight horizontal. There are no further changes during that last part opf the timeframe
then.
Close with OK and check the result:



User Manual to Showcontroller Laser Show and Multimedia Software

67 / 124

Result: The circle is drawn at a bit more than half of the timeframe and remains until the end.

It may have come to attention that not only the points themselves but also their color values get morphed
with this effect. That's why it's not only suitable for morphing two different frames, but also for morphing two
equal frames with different colors.

These are 2 frames to retrace:

A green line with distance 100 interpolated
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Second frame: Add a fade effect with PicEdit via "Gradient"

If morphed, the green line slowly gets fading out edges.
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3.5.9. Parts

It is possible to mark elements in a frame as "Parts" in PicEdit.

Mark Elements in a frame and select in menu "Edit"->"Point Attribute". A popup window comes up where
several parameters can be adjusted, including the "Part" settings:

The purpose of this function is to assign certain effects only to specific parts of the figure. The Pic is added
to the Timeline as a normal Trickfilm. If an effect is placed under this Trickfilm, this effect usually applies to
the whole frame.
Right click on the effect -> "Edit properties of this event" - a dialog opens:
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In this dialog it is possible to specify the part the effect shall be applied to (in this case part 2).
The Parts feature works with these Effects:

Setting a "Move X" on Part 2 would only move the upper right circle.

3.5.10. GeoNet effect

The GeoNet effect allows for distorting the output on the frame level.

This effect is rather ressource intense and requires activation in the Trickfilm event: There are the options
PreGeoNet and PostGeoNet
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These two options specify if the effect should be applied before or after the rest of the effects have been
applied.

This is the Timeline then:

Open the GeoNet effect with double click:
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The most simple distortion can be created by clicking and dragging the grid with the mouse. Only the
closest point is moved the. If the SHIFT key is pressed during the procedure, the whole row can be moved. If
the CTRL key is pressed during th eprocedure, the whole column is moved.
The active parts are colored on key down in both case.
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4. Showcontroller PicEdit

4.1. PicEdit basics

PicEdit is a 3D editor for creating laser frames and -animations.
Drawing laser frames is slightly different to drawing in normal CAD software, as the display options and
necessary parameters for a clean display with a laser system are more versatile and specific than with CAD
prints or views. 

A laser frame is created of single points, which contain this information:

- coordinatex x/y/z
- point color as RGB value (not as index number for PAL)
- information on blanking status
- number of point repetitions of that point
- "Part" index number for special effects

The single PICs can be connected in a CAT file (frame collection) or as single pictures.

Import and export as ILDA frames is possible as well (depending on permissions)

There are severaln tools available for creating laser frames. Many of them provide additional configuration
options on doubleclick on the very icon. It's e.g. possible to set the point number of a circle to 3 to create
triangles.
Some of the tools provide different behavior when used with left or right mouseclick. The circle tool e.g.
either draws a circle or an ellipse. The square too either draws a square or a rectangle.
There are also multiple options for coloring the points and creating color gradients.

4.2. PicEdit interface

Short introduction of the PicEdit interface:
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The main menu is in the top row, as well as the main toolbar. The color pallette and RGB color selection is
on the left side. Right next to it is the toolbar with all the selection, drawing and distortion buttons.

The preview window is also visible in above screenshot. It can be activated via the respective button in the
toolbar.

4.3. Drawing features

 Line
Double click on the icon opens the parameter dialog: 

It is possible to specify a minimal length here. When tracing logos, this value should be rather low.

The line tool is used for drawing ordinary lines. The first click sets the start point, any further clicks set new
end points, starting from the previous point. Normal lines are drawn on left click. Right click draws blanking
lines. Click on the middle mouse button (or scroll wheel) draws color gradients.

 Spline
Draws a spline

Double click on the icon opens the parameter dialog: 

Specify curve values and point density here.

The first click sets the start point. then click the center of the spline and hold the mouse button to modify
the spline. Release

 Freehand
Free hand drawing. Left click, hold and drag. Points are set automatically. A right mouse click sets a
blanking point. 

 Rectangle
Double click on the icon opens the parameter dialog:  
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Specify the numer of corner point repetitions here.
Click and drag with left mouse button draws a square.
Click and drag with left mouse button draws a rectangle.

 Circle
Double click on the icon opens the parameter dialog: 

Specify the number of blanking points before and after drawing a circle as well as the overall number of
points to be drawn. The smaller the circle, the smaller can be the number of points.
Click and drag with the left mouse button draws a circle.
Click and drag with the left mouse button draws an ellipse.

On additionally pressing SHIFT or CTRL it is possible to draw half circles.

 X Corners
Double click on the icon opens the parameter dialog. It looks similar to the spiral dialog. 

Important here is the number of points.
Click and drag creates polygons. Depending on if left or right mouse button is used, it's either a symmetrical
or asymmetrical shape.

 Spiral
Double click on the icon opens the parameter dialog, siehe X-Corners.
Set point number and number of turns.
Click and drag with the left mouse button to create a Spiral.
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 Wave 
Click and drag creates a wave. Release the mouse button and continue moving the mouse to change the
number of waves. Another click ends the drawing process for the wave. An animation of the wave can later
be done in RealTime. 

 Star Tool
Double click on the icon opens the parameter dialog, siehe X-Corners.
The value "Turns" specifies the number of corners. Click and drag with the left mouse button draws the
outter part. Then release the mouse button, continue moving the mouse and thus specify the inner radius.
Another click ends the drawing process. 

 Text Tool
Select the tool and click to the position where the text shall begin.
A dialog opens to specify the text and the font. 

It is also possible to specify size and interpolation steps here. Laser-optimized fonts can be used as an
alternative to TrueType fonts. Those usually lead to better output results.

 Point Tool
Creates single beams. Increase intensity by setting several points at the same position.

Selection:

After having drawn an object, it is possible to select complete objects or single points for further editing. All
functions apply to the previously selected (active) points. All points can be selected by using the key "A".
With using key "I" all selected points becomne inactive/deselected.
Selected points are marked in color.
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 Selection Tool
When having selected this tool, left click and drag a selection frame around the points to be selected. On
release of the mouse button all points within the selection frames become active and corlo marked.

 Select Object Tool
This tool allows for selecting a complete object on left mouse click. Click with right mouse button sets the
object selection to inactive. 

Transformation:

After an Object (or points) has been selected it can be rotated, moved or altered in size.

These are the tools to do so: 

1. Move Point only moves the next point.
2. Move   moves the selected object
3. Scale scales the selected object. Click with left mouse button to specify the center and drag with
clicked mouse button to scale the selected object. 
4. Rotate rotates the selected object. Click with left mouse button to specify the center and drag with
clicked mouse button to rotate the selected object.

Keyboard shortcuts:
"M" = Move
"S" = Scale
"R" = Rotate
It is possible to modify the selected object using the cursor keys in these three modes. Additional pressing
of SHIFT or CTRL changes the step size.

Views:

Change the view of the active working area: Front, Side, Top: 

Lock Axis:

It is possible to lock the third axis, depending on the actual drawing mode. Click on the icons 
to do so, or use the keys X,Y or Z.

4.4. Special features

Several special efefcts can be created via the menu "Transform". These can apply to whole or slectes
objects, depending on their type.

ToPoints:
Reduces an object to its corner points.
A square then becomes 4 beams, a circle becomes a point circle.

Gradient:
Select an object or a part of it and use this function to create a gradient. Start and end color can be
specified in the dialog box that opens.

Accent:
Select an object or a part of it and use this function to create color accents at the active points of the
objects. The accent color can be specified in the dialog box that opens.
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Center:
Places the active object in the center of the drawing area.

Maximize:
Scales the active object to the maximum possible size within the drawing area.

Flip/Flop:
Mirrors a frame at the X and Y Axis.

Rainbow: 
Creates a color gradient in the order of the 64 color PAL pallette.

Interpolate:
Creates additional support points between the selected points. The distance can be specified in the dialog
box that opens.

4.5. Controls

Undo / Redo 
Undoes the last action  / redoes undone actions.

Send / Get Pic 
Moves the active frame to the temporary buffer or collects the frame that actually is in the temporary buffer.
This feature is explained more in detail in 2.6. Frame transfer. 

Scanning parameters 
This button opens a settings window for the output settings and optimizations. These settings ONLY apply
to PicEdit, they do not influence on RealTime.

Active Point Dialog 
Opens a settings window to adjust settings for manipulations single points. Further details in 4.6. Active
Point Dialogue.

CAT features 
- Displays the actuive CAT file.
- Reloads the CAT file.
- Switches to the next frame in the CAT file.
- Switches to the previous frame in the CAT file.

Control Center 
Opens the Control Center. Further explanations in 5. Control Center

Laser On/Off 
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Switches laser outout on/off. Click this icon or use the key "Esc" to do so. 

Preview 
Activates/deactivates the OpenGL preview.

Screen Off 
Blackouts the screen. This can be helpful if the brightness of the screen could negatively influence during a
laser show.

Grid 
Enables / disables a grid for easier drawing. The grid size can be specified in menu Options -> Grid.

Cursor 
Enables crosshairs.

Color Gradient 
- opens the dialog to create color gradients
- activates/deactivates color gradients.
- Map: Converts point color from the color gradient.

Recolor 
Recolors the selected object/points with the selected color.

4.6. Active Point Dialog

Change properties of single points with the Active Point Dialog.

Click the icon  to open the dialog:
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It is possible to move the selection through the object with the cursor keys. The respective active point is
marked in the drawing area. Further key shortcuts can be applied as long as the focus is set to this window.

- Colorindex contains the PAL color numner, the RGB values can be found at the bottom. The Trickfilm
settings specify which value is to be used. 

- Part Number: Parts of a frame can be explicitly specified as "Part", e.g. when drawing a car it is possible
to specify the wheels as part. Thus the wheels can be animated separately in Real Time later on.

- Repeats: Point repetition settings.

- XYZ Coordinates

- Blank, is the point actually drawn as a visible pint? Toggle with key "B"

- Active, shall this point be selected as active to apply further functions (Scale, rotate, size,... )? Toggle with
key "A"

- Delete this point. Klick or use key "D"

- Clone this point (a duplicate of the point is created at the same position)
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- Press "C" to copy the color values of the active point. Flip to anither point with the cursor keys and insert
the color value with "V" at another point.

4.7. Color gradient via background image

Color gradients can be created with a special dialog and can be applied to a frame. These gradients can be
custom made in the dialog, but it ia also possible to load external BMP files as source.

Draw a helix: double click on the Spiral Tool, set values to 80 points and 6 turns:

There are three icons in the upper toolbar:

The first one opens the dialog to create a color gradient. The second one enables or disables the created
gradient as background image.
A click on the third icon maps the colors of the graient to the actual points in the laser frame.

Click the first button to open the dialog:
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Click on "Add" and the option to set the colors appears. E.g. select yellow and confirm with OK.
Click "Add" another time and add black. Confirm again with OK.

A color gradient from yellow to black is displayed. Further gradient types can be selected in the "Type" area.
"Direction" specifies the direction of the gradient, the fader changes the position of the transition. Color
gradient created that way can be saved in the menu "File".
Click on "Close and use Result".

The PicEditor then kooks this way:
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Click on "Map" to assign the background color to the points. The result is visible in the Preview window.
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It's important to consider that color changes are related to points, so the change always happens between 2
points. Thus a square needs to be interpolated first (function "Transform" -> "Interpolate") to add additional
supporting points.

4.8. Color gradient via gradient settings

Another option to create a color gradient is the point gradient. There is no background image used for
coloring points, but they are colored on a point base.

Draw a circle as example:
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Use the "Select" Tool   to select the upper part of the circle. The selected points are color marked.

Click on "Gradient" in the menu "Transform". The color dialog opens.
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Select white as start color: 

Confirm with "OK". A second Dialog opens:

Choose red as end color. Click OK, and the selected part of the circle is applied the gradient:
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A very simple option to draw a gradient is with the line tool. Use the middle mouse button / scroll wheel click
and then draw a line. 

4.9.  Keyboard shortcuts for easy control

These keyboard shortcut are supported by Showcontroller:

Function combine key key
Select Tool none ESCAPE
Copy STRG C
Cut STRG X
Paste STRG V
All aktive none A
All inactive none I
Undo STRG Z
Redo SHIFT-STRG Z
Snap to Grid none G
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Lock X none X
Lock Y none Y
Lock Z none Z
Move none M
Scale none S
Rotate none R
Center SHIFT C
Maximize SHIFT M
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5. Control Center

The Control Center can be accessed from various program parts. 
It controls the laser output as "last control", meaning it's features are the last ones applied after all other
dynamic effects and modifications to a frame have been applied.

5.1. Control Center features

The Control Center:

The timeline tracks assigned to the actual hardware output interfaces in the Control Center. Above picture
shows the start page. One interface has been found in this example.
Each hardware interface can be assigned a track index of 1-20.

There are some global settings, which apply to all hardware interfaces on the lower left side:

"Enable Truecolor"
Enables the linearity correction

"Dynamic Scanspeed" 
If the point number in the output buffer falls below a certain value the scan speed is automatically adjusted
to a reasonable repetition rate.

"Send Artnet"
The DMX values per timeline track are also automatically sent via UDP/Artnet. The target address (universe,
subnet) can be set in the tab "Artnet".

The output settings are on the right side of the window. These are multipliers to the world settings specified
in RealTime. Set size and offset via dragging and dropping the shape. Fine adjustments can be made with
the up/down arrows at the respective values. 

The checkboxes "Invert x" and "Invert Y" invert the very axis. "Swap X/Y" swops the values, which allows for
the use of 90° mounted laser systems.
The checkbox "DMX in" activates the very interface as DMX receiver for external DMX signals.

Switch to the tab "Color Settings":
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Set the color output parameters for the very interface here. The color to be adjusted can be selected with a
click on the '"Gamma" + color' buttons.
The Min/Max faders at the side of the curves can be used to adjust offset and maximum values. The very
Gamma slider influences on the form of the curve.
Thus it is possible to compensate overpower on a color channel or unlinear behavior of diode drivers. 
See 2.2. White Balance for further details on how to use the Color correction option.

The fader "Intensity" specifies the maximum overall brightness for the very output hardware.
The fader "Min Points" reduces laser power if a certain amount of points is undercut.

Next is the tab "Multicolor Setup":

This feature is important for laser systems with more than three different output color channels. Usually
these are OPSL equipped systems with additional color sources like yellow or cyan. If the Multicolor Setup
is activated, the RGB values of a frame are recalculated to match the color lines, so all sources can perform
as required..

At the bottom there is a general limiter function..
"Skip" 
Function is disabled
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"All Colors with same Brightness"
Single color values get reduced. Whit is 100% red + 100% + 100% blue. Thus white would be approx 3
times brighter than the single. On activating this function white would be 33% red, 33% green and 33% blue.
Yellow would be 50% green and 50% red.

Tab "Colormapping":

The tab "Colormapping" allows for routing certain colors to ILDA output color channels. The color shipft can
be adjusted per color channel on the right side.

Tab "Safety Zone":

It is possible to create up to 5 safety zones via drag & drop. The laser power is reduced to the value
assigned for "Intensity" in this area. This can be a hard cut or a smooth transition (Smooth Zone). A safety
zone is only active if the intensity value is <100%.

A quick and easy - and in most cases sufficient, method of creating a safety zone is the horizont: A power
reduction from top to bottom spanning the whole width of the projection area:
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The orange and the red line can be adjusted with the faders next to the zone display. Laser output above the
orange line is 100%. Below the red line, the intensity is as specified with Horizont Intensity fader. In the area
between these lines the intensity fades. This creates a smooth dimming to the safety zone.

The 5 individually configurable safety zones can be configured that way: 

Click the checkbox of the zone to adjust (1-5). Use the controls to adjust size and position of the very zone.
the intensity can be set with the "Intensity" fader. If Smooth Zone is activated, the safe zone gets a smooth
framing, so there is no hard cut from full on to reduced intensity. 

Of course it is only possible to reduce power if there are points to be reduced. Depending on picture size
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and interpolation parameters it is possible that a point is still in the 100% intensity area and the next point
is already in the orange area. In this case there of course is no fading visible. Due to these circumstances it
makes sense to specify the safety zone slightly bigger than necessary.
The setting of safetyzones becomes easier if a grid pattern is projected.

Tab "Artnet":

If the option "Send Artnet" is activated it is possible to specify the IP Address, the universe and the subnet
to which the DMX-Out values of this track shall be sent.
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6. Create the first laser show

A quick way to the first laser show

6.1. Guide to the first laser show with Showcontroller

These are some simple steps how to program a laser show with Showcontroller

Create a new Folder "My Show" e.g. on the Desktop in preparation of the show  programming. Copy the
sound file to be used to this folder already. It is recommended to use a Wave-File for this, as the playback
time can slightly vary depending on the differenr mp3 codecs.

First of all start realTime with an empty project:

Save the project as "My first show" to the folder "My Show" vial menu "File" -> "Save as.."

The title bar of RealTime changes:

Click the clef in the upper toolbar to add ann audio file. The audio dialog opens:
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Click on the red marked button to open the windows dialog. Select the audio file in the "My Show" folder.

The wave form analysis can be initiated after the audio file has been loaded. Click on the icon  for the
wave form analysis. 
RealTime automatically adapted the duration of the show to mathch the length of the audio file after it has
been loaded. As the audio has now been successfully assigned, it's recommended to save the show.

It's time for some show content. Open PicEdit parallel to RealTime: 
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The features of PicEdit are described in detail in 4. Showcontroller PicEdit

Simple start: select a color to the left, then click the circle icon in the tool bar. Color and tool have been
specified. Click to the center of the drawing area with the left mouse button, hold it and drag open the circle:
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A click on the icon in the upper toolbar showing an arrow pointing right copies this frame to the temporary
buffer. Switch over to RealTime, zoom the starting area of the show with the scroll wheel a bit and place the
just drawn frame to the timeline. To do so, right click at an empty space in the timeline and select "Add from
Temp".
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A Trickfilm Event is automatically created and the Pic is loaded from the temporary buffer.

This Trickfilm event can then easily be positioned via drag and drop or adapted in duration. Drag the duration
of a length of ca. 8 seconds and click on the preview window icon:
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Click the black play icon in the bottom tool bar, and the timeline plays. As soon as the cursor reches the
Trickfilm Event on the timeline, it is played pack and displayed in the preview window:

The Temporary Buffer is an easy way for getting laser frames to the timeline. If a frame shall be used more
often it makes sense to save it a *.pic file. See more on this in section 7.4. PicBrowser

Further proceeding with the animation. The circle shall fade in smoothly and change it's size. Double click
an empty area in the timeline. The Effects dialog opens:
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Click on the Event "Fade In" and place the event in the timeline in the track just under the Trickfilm event.
Set it to the desired duration.

If the play back has not been stopped in the meantime, the effect of the changes should already be visible in
the preview window. With Showcontroller it is possible to program and directly see the results live in the
preview window in real time.

Another double click to an empty area on the timeline to add the event "Size XY". Place this in the track
under the fade-in effect. 
After having placed the Size XY effect, no change is visible in the preview window yet:
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Open the new event with a double click:

The Animator window shows up, which is used for the configuration of many effects. Both the begin and the
end value to the top left are still set to "1". "1" means 100%, "0.5" means 50% etc.
Change the begin value to 0.2 and close the window with "OK".

The preview shows how the circle changes its size on fade in.
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These were the basics. Further details on ralTime, the timeline, different effects and events as well as a
detailed explanation of the Pic editor can be found in the previous chapters of this manual.
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7. Special features

Showcontroller comes with some special functions that extend the standard software features.

7.1. Artnet control

Many lighting applications use Artnet as communication standard.

Showcontroller supports Artnet and can output it in all software versions. Artnet output happens parallel to
the DMX output of the very hardware interfae. It is necessary that at least one hardware interface is
connected to use Artnet, otherwise no output thread can be created (as it's created parallel to DMX, which
also requires a hardware interface to be mapped to). Place a DMX event in the timeline for testing purposes
(double click an empty area in the timeline, select DMX 1 channel event and specify channel and value).

Open the Control Center and activate "Use Artnet". Switch to the tab "Artnet" and specify LAN address,
subnet and universe.
As soon as "Use Artnet" is selected, DMX via Artnet is sent and also the DMX-In buffer from the receiving
hardware interface is ovrewritten by the Artnet-In buffer. 
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The output can be checked with free tools, like the "Artnetominator". Here the value 200 is specified on
channel 1, universe 0, subnet 2:

Sending of DMX is linked to the internal mechanism. Output happens only for changed values. 

7.2. TimeCode

Remote controlling a software via external timecode is essential, especially if it comes to larger projects,
where each subsection has their own controls. In this case all subsections are synchronized via timecode.

The most cost efficient solution is the use of MTC (MIDI Timecode). Showcontroller can receive MTC and
can also send to a MTC hardware.

If used locally it is also possible to create a virtual MIDI port. Thus the MTC data is handed internally from
one software to another one on the same PC.
Free for private use is e.g. LoopMidi. Set up the MIDI port, start Showcontroller and open the Audio
settings. 
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The virtual MIDI port "Showcontroller V-Midi" is preset.
To play a show through MIDI-In timecode, set the timecode source to "MIDI Timecode (MTC)". Thus not the
show audio/media file is source for the timing but the external MTC.
Close the window and click "Play".
Nothing happens - exactly as it should be: As long as no external timecode is provided, the show does not
start to play. As soon as external timecode is received, the show starts playing at the time provided by the
timecode.
Of course, as the timing source has been changed from internal media to external timecode, Showcontroller
does not play back any audio any more. The audio must be provided by the timecode master then (MTC
source).

If "Send Timecode" is activated and the Timecode source is still "Media file", then Showcontroller is the
Master MTC provider, plays the audio file and sends out MTC to the virtual MIDI port or another physical
MIDI device. In case SMPTE is used, a converter SMPTE -> MTC is required (e.g. Motu interface)

7.3. Realizzer implementation

The software "Realizzer" is a professional solution for visualizing DMX units, laser and video in a custom
created 3D environment. Realizzer reads Artnet and laser data from Showcontroller and plays them back.

Realizzer is only supported in the Showcontroller PLUS Version.

The Realizzer demo version has a time limit of 5 minutes. This is sufficient for a test though.
Start realizzer, adjust the network settings, start Showcontroller and load a show.
A click on the Realizzer icon activates the output:
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In this example the laser track 2 is routet in the Control Center to the projectors 2+3 in Realizzer and x-axis
has been inverted for the left satellite projector (number 3).

Showcontroller supports all features of Realizzer. It is also possible to render Videos from the visualization.
To do so, Set the Timecode to "SNTC" = Synchronorm-Timecode in the audio settings. Realizzer then
sends timecode to Showcontroller and "fetches" the frames for the rendering.

7.4. PicBrowser

The PicBrowser is a preset and extendable collection of frames. There is a subfolder "Pic" in the folder
"Showcontroller" that has been created during the installation of the software, per default it is on the
desktop. There are several subfolders in this "Pic" folder.
Own folders can be created there too, e.g. "Own Pics". If a Pic has been created in PicEdit, it should be
saved there.
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How can a pict from the PicBrowser be used on the timeline?
Right click an empty area in the timeline, a context menu opens. Select "Add from PicBrowser". A window
opens with selection options.

A preview of the frames in the very folder is shown.
Doubleclick on the desired frame, and a Trickfilm event is created that has the Pic loaded to.

The Trickfilm event is created at the position where the right click has been made.
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Double click on the Trickfilm event, change to the tab "Picture" and the destination, where the frame has
been saved to, is displayed.
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A frame loaded to the Pic buffer always is treated with priority over a CAT picture. If a CAT picture shall be
used for this Trickfilm event rather than the one from the Pic buffer, click "Clear" to erase the picture from
the Pic buffer. Of course the Pic is not deleted from the PicBrowser, just from the Pic buffer of the very
Trickfilm event.

7.5. ILDA import and export

The ILDA format is a common, open file format for transferring laser frames between different platforms /
software progreams / playback systems.
The older ILDA format versions based on color tables, modern versions use RGB color values.

To correctly display older type ILDA frame ist is necessary to specify the correct color table. This color table
must be  available as PLA file.
These steps explain how to color and potentially deconstruct an ILDA file in PicEdit.

Start PicEdit:

The loaded color palette is shown to the left. Double click on one of the colors and a dialog opens:
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Use "File" -> "Open" to load either the included "ILDA.pal" or use any other custom PAL table.

After the suitable PAL table has been loaded, click on the CAT symbol   to open the CAT dialog.

Click a free space to specify the start index for the import.

Then an ILDA file is imported, Click on "File" -> "Import" -> "ILDA":
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As it's an old ILDA file of format 0, that depends on pallette colors, but we're using the RGB color system,
all frames are only shown in white. With a special feature it is possible to read the color index numbers from
the frames and write the corresponding RGB color values to the frames.

Use menu "Animation" -> "Recolor all" and all frames become colored.

An ILDA file sometimes acts like a container and contains several single frames or animations. To not create
unnecessary data it is possible to:

- save single frames as Pic file to use them in RealTime via PicBrowser (select and menu "File" -> "Save as
Pic")

- save animations of several frames as Ani file. These frame sequences can then later be loaded to a
Trickfilm event:
Click on "From" and "To" to set the start and the end frame for the animation. The number of the very
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selected frame is taken on a click on the very frame. In this example the animation should span from #14
and #21. 
So, click on frame 14, click on "From", click on frame 21, click on "To" and click on "Animation" -> "Save
"From" until "To" as ...". Save the animation
Switch to RealTime. Place a Trickfilm event in the timeline and open with double click. Switch to the tab
"Animation":

Click on "Load" and load the .ani file that has just been saved:
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Close the window with OK and check the result in the OpenGL preview.

7.6. 3D animations from Blender

Blender is a free 3D tool. Due to the huge number of features it is not that easy to use. However, it provides
several very mighty possibilities to create 3D animations and frames that can easily be imported to
Shwocontroller.

To create laser frames from Blender, it is suggested to use the Freestyler SVG Export extension. Thus it is
possible to create single frames or animations as SVG files. Those files can then be imported to laser
frames with the SVG Converter of Showcontroller, which dan be used in Trickfilm events.

The necessary script file that also exports colors has been developed by Thomas Beck of the Blender
Foundation. 

First activate the script in Blender.
Start Blender and switch to the settings via menu "File" -> "User Preferences"

Switch to the tab "Add-ons" and search for "svg". Select the result "Render: Freestyle SVG Exporter".

Some important settings in Blender to make the export/import work:

Render ettings:
Set the resolution to a value in 1:1 relation. The higher, the better, but the rendering takes longer.

Activate Freestyle and Freestyle SVG Export.
It's also specified here if a single frame or a complete animation (=several single frames) should be created
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Some example settings in "Render Layers":

Specify the output directory for the SVG files:

The very "material" color becomes the drawing color:

The default shape is a cube. Click F12 to start the rendering and preview the result:

If everything is set correctly save these settings as "Default File". This is very helpful for future exports.
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Then start the SVG converter and load the file:

The point reduction and sorting apply now. Try out several settings to find the best result. Save the imported
file as Pic or Animation via menu "File".

Even though it is not possible to provide a full, detailed introduction to Blender, this is a short example how
to create a 3D text:

Delete the cube from the startup file.
Click on "Create" -> "Text" on the left side.



User Manual to Showcontroller Laser Show and Multimedia Software

116 / 124

Move the text to the center and hit the tabulator key to switch from the object mode to the edit mode.

 
---->
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The text can be edited then...

Switch to the object settings on the right and adjust size / rotation as desired:

Adjust the extrude value in the text mode:
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this is the result ...

Add solme color ...

Switch to the material tab , click on "New" and adjust the color:
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Result: 

Press "F12" to see the rendering result. Adjust position,. rotation and size to the desired values. 

If the rendering result looks like this:
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a suitable SVG file has already been created. Swicth back to the Showcontroller SVG converter:
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Optimize with "Reduce Points" and the result is fine.
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8. Tips & Tricks

A small collection of tips and tricks for the every day work with Showcontroller (to be extended time by time)

8.1. Create SFX and Loop events

SFX or Loop-Events are like a small "timeline in a timeline". Such an event can be used for combining
several effects in one Event.
Animations that have been created that way, can be saved as a group and reused in another show.

It is also possible to export parts of an existing show as SFX, as long as the show has been released for
exporting by the creator. If parts of a show of another artist are used, it isstrongly requested, that the name
of the creator and the respective show is named in the context of the show these parts are used in.

There is a small animation on this timeline, consisting of two Trickfilm events and the corresponding
animation effects: 

Set the start and end marker to the desired position and select everything that is to be exported. Press the
SHIFT key while dragging a selection frame with the left mouse button clicked.
This is how it should look like:

Right click to an empty area on the timeline, the context menu opens:
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Click on "Copy all active Events between Start/Stop Markers to new LoopEvent"

The original events can be deleted. Open the newly created Event with a double click:
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As SFX only allows one event per timeline track, the show sequence looks slightly different. However, the
output result is the same. If a name or comment is specified, it is displayed in the timeline.

If a "Screenshot small" is created in the OpenGL window, this screenshot can be inserted here. Save the
whole event via "File" -> "Save as".

To reuse the event later, place an empty Loop Event in the timeline, open it with double click and load the
file via "File" -> "Load"
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